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1. A program 

 

Nyílt forráskód  Audacity ingyenes, nyílt forráskódú szoftver a szerkesztést hangok több 

pálya. Audacity felveheti, lejátszhatja és szerkesztheti szavak és zene. 

WAV, AIFF, MP2, MP3, FLAC és OGG audio fájlokat lehet importálni 

és exportálni. Ez használ közös műveletek, mint a kivágás, másolás és 

beillesztés, és korlátlan Undo. Ez keverjük össze, és adjunk hozzá 

hanghatások és állítsa kötetek egyszerű módon. 

 

Verziók  Audacity által fejlesztett világméretű hálózata programozók. Jelenleg a 

legfrissebb verzió a 2.0.0. Ez elérhető a számos operációs rendszerek és 

platformok, mint a Windows (98-ig bezárólag Windows7), Mac OS X 

és a Linux / Unix. 

 

Támogatás  Lásd http://forum.audacityteam.org/ 
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2. Letöltés és installálás 

Letöltés  Letöltheti Audacity a http://audacity.sourceforge.net/download/, amely 

szintén kínál néhány alapvető információt és utasításokat, különösen a 

forráskódot. Győződjön meg róla, hogy töltse le a megfelelő verziót az 

operációs rendszer. Telepítése Audacity for Windows és a Mac OS 

követi a szokásos telepítési eljárás során. Sok Linux disztribúcióban 

megtalálható Audacity. Néha azonban ezek a régebbi Audacity. 

Audio-kodekek  Annak érdekében, hogy létrehoz mp3-fájlokat közvetlenül Audacity, 

szükséges telepíteni a "béna MP3 kódoló" - az engedélyezési okokból 

nincs előre telepítve, és le kell tölteni külön-külön. Ugrás a 

http://audacity.sourceforge.net/download/, ahol megtudhatja, hogy hol 

kap béna for Mac OS és a Windows, ez is lehetséges, hogy töltse le és 

telepítse a szükséges kódoló közvetlenül Audacity követve az ösvény 

Szerkesztés> Beállítások> könyvtárak. Lame for Linux könnyen 

telepíthető is. Megtalálható egy kész használható rpm csomagot 

http://packman.links2linux.de/. Ott is olvassa fel a hivatalos 

licencszerződést, és fontosnak tippeket, hogy melyik csomagot melyik 

illik Linux telepítést. Az Ubuntu-Linux van egy sánta csomag a 

multiverzum tárolóból. 

A telepítés után a FFmpeg könyvtárak (Szerkesztés> 

Beállítások> 

Libraries), Audacity 

támogatni fogja a különböző más 

formátumokat és kodekeket, 

beleértve a saját formátumokat, 

mint a AC 3, WMA és M4A 

(MP4). 
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Adaptációk  A munka kényelmesen Audacity, bizonyos kiigazításokat kell tenni a 

File> Preferences: 

 A könyvtárak a LAME MP3 encoder kell venni a gombbal 

Könyvtár keresése. Linux a fájlt kell hívni libmp3lame.so, a 

Windows lame_enc.dll. Érdemes-, hogy válasszon egy igen nagy 

adatátviteli sebesség (pl. 160/192/256) itt, hogy mentheti a fájlokat a 

helyi merevlemezen vagy a helyi web kiváló minőségű. Szeretné 

közzétenni produkciók az interneten kisebb bitrátával kell használni, 

azonban (lásd a Mentés fejezetet a részletekért).  

 Szerkesztés előtt, az Import / Export opciókat kell beállítani, 

hogy biztonságosabb legyen bejelölésével Készítsen 

másolatot tömörítetlen audio fájlok 

szerkesztése előtt. Ez biztosítja, hogy audio fájlokat 

használ -, és hogy lehet oszlik meg a merevlemezt, flash meghajtók 

és MP3-felvevő - menti a projekten belül. Ez megakadályozza, hogy 

bosszantó az adatvesztést.  

 Mikor jön a megtakarítás projekt adatait, hasonló beállításokat kell 

választani ugyanazon okokból. A projektek alatt ellenőrizze a 

mindig másolja az összes audio a projekt 

(Always copy all audio into project). 

 A Tracks ellenőrizze Kijelző frissítés közben 

(Update display while playing), így a jelenlegi helyét 

a kurzor mindig látható . 

 Az Interface alatt választhat egy nyelvet a menük megjelennek 

be egyik előnye az Audacity: 30 nyelv már szerepel, és több hozzá 

rendszeresen.  

 A “Keyboard”  billentyűzet segítségével válassza ki néhány 

hasznos billentyűparancsok, például a Plusz és mínusz a nagyítás és 

kicsinyítés. Sok parancsok telepítve, mint gyorsbillentyűket. A 

gyors munka, nézd meg a feladat kulcsok ajánlott, akkor található 

egy lista a végén ezt a kézikönyvet. 

 A Tracks lehetőség engedélyezése vonalakat (Enable 

cut lines  ) kell aktiválni (lásd a 6. fejezetet).  
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3. Az első felvétel és a visszahallgatás 

Rögzítés és moduláció   Audacity megnyílik a pálya terület üres. Amint felvételek készülnek, 

vagy már meglévő audio fájlok megnyitása, az új pályák jönnek létre. 

Ha a számítógép rendelkezik egy működő audio konfiguráció, akkor 

lehet kezdeni a felvételt, ha megnyomja a piros Record gombot. A 

kimeneti szint szabályozható a csúszka a mikrofon szimbólum 

bemenet kiválasztása (pl. vonal, mikrofon, stb, attól függően, hogy a 

hangkártya) történik a pop-down menüből mellett a kimeneti csúszka. 

Audio eszközök, mint a MD játékosok mindig csatlakoztatni a vonal a 

hangkártya, mert csatlakoztatni őket a mikrofon bemenet is könnyen 

vezethet a túlvezérlés. A minősége a felvétel ellenőrizhető módon, a 

moduláció kijelzőn, amely nem lehet több mint-6dB. A monitor 

funkció lehetővé teszi, hogy előre hallgatni: egy kattintás a moduláció 

kijelzőn - a felvétel előtt - azt mutatja, hogy a bemeneti szint. 

Kattintson a Szünet gomb segítségével megszakíthatja a felvételt, 

kattintson a Stop gombot a felvétel leállításához. (Megjegyzés: ha a 

Szünet gomb megnyomásakor Audacity teljesen blokkolva!) További 

felvételek először létrehoz egy új pálya, így a véletlen törlés a korábbi 

felvételek kizárt. Nyomja meg a Shift és a Record gombot, vagy Shift 

+ R ugyanakkor felvétel folytatásához a kurzor aktuális hely (lehet 

tenni ugyanazon a pályán, de ebben az esetben ügyeljen arra, hogy 

helyezze után fennálló tart, a végén a pálya ). 
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Visszajátszás  Akkor lehet kezdeni, szakítani, és állítsa le a lejátszást az ismerős 

szimbólumok a lejátszás eszközök tálcán tetején. Könnyebb 

elindításához és leállításához nyomja meg a Szóköz, és egy kis 

szünet lejátszás egyszerűen érintse meg a P gombot a billentyűzeten. 

(Megjegyzés: ha a Szünet gomb megnyomásakor Audacity teljesen 

el van zárva!) 

Ha szükség van, hogy gyorsan hallgatni az egész audio, kattintson az 

uralkodó az időbeosztásának, Audacity folytatja a lejátszást a 

kiválasztott kurzor. 

Shift és A megáll (és kezdődik) lejátszás nélkül a kurzor kihagyom 

vissza az elejére a pályán.  

Azonnali visszajátszás  Amint, kattintson az idővonal, a lejátszás indítható azonnal anélkül 

kiválasztott lejátszási területeken. 

Gyors előre is lehetséges. Lejátszás közben érintse meg a Kurzor 

jobbra a billentyűzeten, hogy kihagy egy pár másodpercig. Hogy 

beállítsa a hosszát az átugrott időközönként menjen a 

Szerkesztés> Beállítások> Lejátszás. 

 

  Egy másik kényelmes funkció 

play-at-speed („Mickey Mouse” 

hatás): A átírására eszközzel (ami lehet aktiválni a Nézet> 

Eszköztár), akkor gyorsítani (vagy lassítja) a lejátszás tempó. 

Állítsa be a kívánt lejátszási sebességet a csúszka, majd indítsa el a 

lejátszást, kattintson a kis zöld nyíl gombot. 
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4. Audio fájl importálása  

Importálás 

 

 

 

 

 

 

 

 

 

  

 

 

 

 Audacity import audio a WAV, MP2, MP3, AIFF és OGG 

formátumban. Válassza a Projekt> Import audio 

integrálni már meglévő anyagot a projekt ablak nyílt erre a célra. Ha új 

audio behozatala, akkor automatikusan egy új pályán. 

Mivel Audacity 1.3.6, az FFmpeg könyvtárak lehetővé teszik a 

használatát számos más formátumban. Lásd a 2. fejezet a részletekért. 

 

Válassza a Fájl> Megnyitás nyisson meg új projektet ablakot és 

másolás között oda-vissza a projekt ablakokat. Így lehet szerkeszteni 

nyersanyag külön környezetben, majd másolja és illessze be a teljes 

projekt. Az is lehetséges, hogy drag and drop audio fájlokat 

közvetlenül a fájlkezelő az operációs rendszert Audacity projekteket. 
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5. A nézet beállítása 

Horizontális, 

vízszintes nézet 

 

 

 

 

 

 

 

 

Vertikális, függőleges  

nézet 

 A munka elkezdése előtt a hang, a megfelelő nézet kell választani: 

nyomja meg az F11 váltani teljes képernyős. Állítsa be a hangot a 

vízszintes tengely mentén (nagyítás és kicsinyítés) gyakori, hogy a + 

és - gombokkal a numerikus billentyűzet. Lásd a 2. billentyűzet 

parancsok. Vagy meg lehet változtatni a vízszintes skála az egér kerék 

miközben Ctrl nyomva. És végül meg kell gombokat a nagyítás és 

kicsinyítés, és illeszkedik a projekt vagy a 

kiválasztás az ablak. Akkor elfér egy válogatás 

az ablakon, még gyorsabban rajz az egeret, hogy miközben a jobb egér 

gombot lenyomva. Ellenőrizze a funkciók mind Audacity gombokat 

pihen az egér őket mozdulatlanul, vagy kattintson. Ahhoz, hogy 

megtalálja az ideális beállítás az egész projekt, nyomja meg a Ctrl és 

az F. 

 

Meg lehet változtatni a skála a pálya mentén a függőleges tengely az 

egérrel. Az egérmutató alakját veszi fel a kettős nyíl szélén a 

hullámforma és megváltoztathatja a méretét a pálya a függőleges 

tengely mentén. Nyomja meg a Ctrl + Shift + F, hogy 

optimalizálja a módosítást a teljes projekt.  

 

Minden pályán van egy kis fekete háromszög alján a címke (cím), 

kattintson rá, csökkentheti vagy növelheti a kilátás a hangsáv. 
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  Növelheti a skála egy bizonyos részét a hullámforma az egérrel 

kattintva a függőleges skála a címkén. Tartsa lenyomva a Shift 

gombot, hogy csökkentse a méretét lépésről lépésre. Az aktuális szintet 

nyit a pálya menüt a nyíl a címke, és válassza a hullámformát 

(Waveform).  

Felcímkézett track / 

Label track 

 A címke track segít hogy el ne vesszen a saját anyag. Meg lehet 

beállítani markerek és megjelölni és elnevezését teljes részeiben 

hanganyag. Válassza a Tracks> Új> címke Pálya (vagy: 

Ctrl + B), hogy hozzon létre egy címkét pályán, ha azt szeretnénk 

is beállít egy marker a helyszínen, ahol a kurzor utolsó állva. Ha a 

teljes audio átjáró kiemelték, a marker vonatkozni fog, hogy az egész 

szakaszon a címke pályán. Mindkét esetben, akkor írja szöveges 

kapcsolatos helyszínen, vagy a folyosón. Mindaddig, amíg a kurzor a 

címkén pályán, billentyűzet bejegyzések direktben text marker. Azt is 

importálhat tartalmat ki egy szöveges fájlt a címke pályán. A 

szövegbevitelre később mozgatni az egérrel. Törléséhez kihúzó, ürítse 

ki a szövegmezőbe teljesen. 

 

Felvétel és lejátszás közben A Ctrl + N, hogy új marker. Ezt fel 

lehet használni felvétel közben a szerkezet hosszú felvételek, mint a 

sajtótájékoztatók, előadások valós időben: beírhatja nevű vagy rövid 

jegyzeteket a tartalmat a címke pályán. De légy óvatos: győződjön 

meg róla, hogy dolgozik a címke pályán, különben a szóköz leállítja 

a felvételt! 

Eszköztár  Az általános nézet az Audacity lehet módosítani. A bal oldalon 

minden eszköztár található egy külön sáv: pihen a egérpointer rajta 

jelzi az az eszköz funkcióját. De akkor is használni, hogy vegye le, és 

helyezze át eszköztárakat.  
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6. Szerkesztés többfunkciós eszköztárral 

Többfunkciós mód 

 

 A gyors és könnyű vágást, a multi-funkciós mód 

lényeges: ha be van kapcsolva, minden közös 

munkához lépéseket lehet megvalósítani anélkül, 

beállítása eszközöket. Az alábbi leírás feltételezi, 

hogy az Asterisk gomb. Ez azt jelenti, hogy a multi-funkcionális 

eszköz, az egér végre három különböző funkciók - attól függően, hogy 

az aktuális pozícióból a hullám. A többi eszköz gombokat, akkor 

viszont más szerkesztési funkciói ki és be tetszés szerint. 

Elsődleges funkció:  

skála létrehozása 

(kiválasztó 

eszközként) 

 

 Amikor az egérmutató jelenik meg egy beillesztési pontot 

(multifunkciós üzemmód a görbe), kattintson és húzással jelölje ki a 

sor audio és szerkeszteni – „rángatás”, mint sok pálya, amit akar. Ez 

gyakran szükséges, hogy beállítsa a határait a klip egy későbbi 

időpontban. Ehhez az egér mozgatásával a szélén a klip. Amint a 

kurzor nyíllá változik léphet a határokat. Vagy egyszerűen Shift + 

kattintás egy új pontot a pályán, hogy újra a határokat. Shift + 

Pos1/Home vagy Shift + End jelölje meg a kiválasztás elejéig, 

vagy a pálya végén, csakúgy, mint a szöveges feldolgozó programok. 

A kezdet, vége és hossza válogatott jelzi az állapotsorban az alsó 

részén a Audacity ablak. A lejátszás csak játszani a kiválasztott 

tartományban. 

Egy kattintás az üres szürke háttér terület a címke lesz az egész pályán. 

Kattintson duplán a klip, hogy jelölje meg. Jelölje meg a teljes (multi-

track) projekt Ctrl + A. A terület a kurzor pozíció és egy másik 

helyre is fel kell tüntetni a Shift + kattintás. Kattintson a 

Timeline lejátszás bármilyen helyzetben törlése nélkül a kiválasztást.  

Kijelölt rész 

előhallgatása  

 Ezen funkció használata is nagyon praktikus. Ha a C gomb 

megnyomásával (illetve a lejátszás gombot, miközben Ctrl) a vágás 

szimulált: meg lehet hallgatni egy sor előtt néhány másodperccel, és a 

vágás után régió kihagyva a jelölt szakaszt. Beállításához a hossza a 

vágás előnézeti területen a Szerkesztés> Beállítások> Lejátszás. 

Visszajátszás a kijelölt 

részről 
 Lehetőség van játszani a különböző határ vagy indul azt 

kezdeményező lejátszást a B gombot. Attól függően, hogy a kurzor 

aktuális helyén lejátszás a tartomány határán, vagy megy felé. 
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A kijelölés 

helyzetének mentése 
 A pontos helyzetét a régió az idő tengelyen lehet menteni és 

visszaállítani. Menj a menüpontok Szerkesztés> Régió 

Mentés vagy régió visszaállítása.  

Másolás, beillesztés, 

törlés 

 A klip csak szerkesztett olyan szabványos parancsokat 

Ctrl + C billentyűkombinációt a vágólapra, Ctrl + V beillesztés, 

Ctrl + X vágni, és a Del billentyűt is a megfelelő gombokat a felső 

ablakban területet. Törlése Audio a Del gombot, vagy a Backspace 

nem jelent cutlines! 

Ha dolgozik, több pálya, egy sor lehet jelölni, és törölni több sávon is. 

Ha törölni kell egyes szegmensekben - például egy pályán és a pálya 

három anélkül pályán 2 - a következő eljárást javasoljuk: válassza ki a 

tartomány sávon, válassza a pálya a 3. Shift + Kattintson a 

címke (cím), majd törölje a Ctrl + X. 

Audió lehet beilleszteni leírtak vágólapról bármilyen pályán, beleértve 

számokat más Audacity ablakok. Ugyanakkor az egész audio kell 

lennie az azonos mintavételi frekvenciát, általában 44,1 kHz. 

Track-ek igazítása  Gyakran van értelme szerkeszteni több lépésben, különösen akkor, ha 

a munka a kifinomult gyártási. Elkerülése érdekében felhalmozódó és 

egyre több tracket, és elveszíti az áttekintést, célszerű igazítani hang 

különböző pályákon. Az Tracks> igazítása lehet kombinálni a 

teljes audio kiválasztott sávokat belekeverni egy pályán.  

Vágó kijelölések  Munkavégzés a „vonalakat” funkció aktiválva van jelentős előnye, 

hogy miután törölt audio rész egy klip, a vonal jelzi a helyét a 

szerkesztés. Kattintva ezen a vonalon később bármikor visszavonja a 

szerkesztés, hogy a törölt anyagot helyreáll. Ez a funkció azonban 

aktiválni kell előre az Edit> Preferences> Tracks. 

Második funkció: 

A hanganyagok 

mozgatása 

(a hangszegmensek 

helyzetének változása) 

 

 Áthelyezése egy audio szegmens egyik helyről a másikra, akkor fogd 

meg (multifunkciós üzemmód), miközben lenyomva tartja a Ctrl és 

mozgatása. Több szegmensében a különböző pályákon lehet mozgatni 

együttesen, ha már kiválasztott egy csoport. A hanganyag egy egész 

pálya lehet mozgatni, ha a Ctrl + Shift vannak nyomva. 

Amikor mozog a szegmens elejére a pálya, akkor könnyen megy túl 

messzire, így az anyag eltűnik a „nirvana” maradt a nulla vonalat. Ön 

is meg tudja ezt keresztül Tracks> Align pályák> igazítás 

nulla. Külön klipek, használjuk a funkciót a Szerkesztés> 

Split vagy a Ctrl + T, ez létrehoz egy másik klip elején, ahol a 

kurzor volt elhelyezve. Ez fordítva is működik: mozgó két klip együtt, 
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majd kattintson az érintkezési vonal, amely elválasztja őket, teszi őket 

egy klip. 

Sync-Lock  A funkció Sync Lock Tracks köti pálya mentén az idő tengelyt 

úgy, hogy egy ügy egy számot (például egy edit) hatással lesz a többi 

is, és az időzítés marad. Ez azt jelenti, hogy ha törölni vagy beszúrni 

valamit az egyik pályán, az anyagot a többi szám is visszaköltözött 

vagy oda. Egy csoportot alkotó pályák, mint ez a munka le egészen a 

címke pályán, ha van, és a számokat kezelt szinkronban vannak egy 

szimbólum a fejlécben a pályán.  

harmadik funkció: 

hangerő változtatása 

(envelope tool) 

 

 Hangerő pontokat lehet létrehozni határán a hullámforma és a kissé 

sötétebb területet. Lásd a következő fejezetet, hangerő szabályozás, a 

részletekért. 
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7. Hangerőszabályozás 

Five options  A hangerő egy egész szám, egy számon belül a hullámforma és 

automatikusan: 

1. 

Label 

 Van egy hangerő csúszkát a címke a hangerőt az egész pálya 3 dB-es 

lépésekben. Tartsuk lenyomva a Shift, hogy 1 dB lépésekben. 

2. 

Volume points 

 Ha, amint azt a 6. fejezetben, a 

multi-funkciós üzemmód aktív, 

akkor a hangerőt a hangerő pont a 

hullám. A határ a világosabb és a 

sötétebb szürke területek, az 

egérmutató két fehér háromszög. 

Tartsa lenyomva az egérgombot, 

hogy egy pontot, és módosítsa a 

hangerőt görbe. Ön mozgathatja a hangerőt pontokat egy későbbi 

időpontban, vagy törölje őket azáltal, hogy őket a pályán kívüli 

területet. 

3. 

Fading  

 Megszokott dolog, hogy egy hang, hogy - például a rögzített idézet - 

kezdődhet és végződhet egy elhalványulnak. A leggyorsabb módja 

annak, hogy hozzon létre egy elhalványulnak fog menüpont Effect> 

Beúsztatás (Fade Out), miután kiválasztotta a hang folyosón. 

Az egyetlen hátránya, mint a fakulásnak látható kötet pontot: nem 

lehet szerkeszteni a fader görbe egy későbbi időpontban. 

4. 

Auto duck 

 Ez nagyon praktikus 

használni Effect> Auto 

Duck, ha dolgozik, a 

felvételeket egy idegen 

nyelven: a fader görbe egy 

kiválasztott tartományban a 

pálya által ellenőrzött hangot 

a pályán alatt. Csak egy pár 

kattintás az eredeti nyelven 

felvétel halvány alacsony ahol a fordítás legyen felette.  
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5. 

Erősítés 

 Az Effect> Erősítés akkor fokozatosan növeli a hangerőt jelölt 

tartományok vagy az egész projekt. Mark az egész projekt a Ctrl + 

A. Ahhoz, hogy a biztonság kedvéért, válassza ki a csúcs amplitúdója 

kb. -1 DB egy-track projektek, mivel egyes készülékek reagál 

kellemetlenül teljesen felerősített hang. Vagy válassza Effect> 

normalizálás, ami -3 dB előre kiválasztott. Annak elkerülése 

érdekében, túlvezérlés multi-track projektek gyakran van értelme, 

hogy maradjon néhány dB-lel teljes amplitúdóval (0 dB), mert a szint a 

különböző pályák add fel, és a hatás a lehetőségek csak kiszámítani a 

szintjén az egyes zeneszámokat. 

 

Minden hangerő beállítás megmarad, ha az exportáló. De légy óvatos: 

Tracks, amely elnémítja a címkén (új-os verzió 1.3.4), nem hallatszik 

export egy új fájlba. 
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8. Mentés és exportálás 

Számtalan lehetőség  Kezdetben lehet létrehozni és menteni (multi-track) projektek 

Audacity, majd újra megnyitja őket Audacity bármikor a további 

szerkesztéshez. De akkor is export audio szegmens vagy egy teljes 

projektet fájlok számos más népszerű szoftver formátumokat. 

Projekt elmentése  File> Save Project / As ... elmenti az aktuális Audacity 

fájlt. A könyvtár tárolja fájl nevét végződő *. Szabályzatot. Fájl> 

Megnyitás hozza a projekt vissza rá a képernyőn a további 

szerkesztéshez. Az audio tárolja a kis lineáris audio fájlokat (*. Au, V-

audiofile) egy al-könyvtár az azonos nevet. 

Audacity 1.3.2 bevezette az automatikus mentés funkció: Audacity 

menti a program a háttérben, rendszeres időközönként. Ahhoz, hogy 

ezt a funkciót, vagy állítsa be a szünetekben a Szerkesztés> 

Beállítások> Projektek. Ha az Audacity, vagy a számítógép 

lefagy, a következő alkalommal, amikor elkezd Audacity azt észleli, 

hogy a projekt nem mentette kézzel, és kéri, hogy a projektet meg kell 

állítani. Ha vannak sérült fájlokat, Audacity javítást, kérésre. 

Tömörített mentés  Mint az Audacity 1.3.7. Projektek menthetők tömörített formában. 

Sávonként, a hang menti *. OGG formátum a kiválasztott átviteli 

sebesség. Előnye: A projekt adatok kisebb méretben, és általában 

igényel egy tizede az eredeti tárhely, attól függően, hogy az átviteli 

sebesség. Hátránya: most a lépcsőzetes hatás (lásd a következő szakasz 

az „Export”) lesz jelentős a projekt szintjén is. 

Exportálás MP3, OGG  

M4A, WMA… 

fájlokba 

 A Fájl menü is kínál export funkciókat. Exportálás keveri egész 

projektek hangfájl Export létrehoz egy audio fájlt a projekt 

keretében - egy vagy több szám - amelyet választott. A kivitel 

projektek WAV (lineáris módon), valamint a csökkentett adat 

formátumok, mint az MP3 és OGG. Az adatok csökkenés bitráta lehet 

előre kiválasztott exportálása párbeszédablakban az opciók. 

Létrehozásához MP3 fájlok, a lame kódoló kell telepíteni (lásd 

Telepítés). 
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  A nyílt forráskód OGG kiváló egy audio-technikai szempontból, de a 

lejátszás és szerkesztő programok még mindig nem túl gyakori. Nem 

szabad megfeledkezni arról, hogy a munka az adat-csökkentett 

formátumok vezethet áttételes hatások: audio van kódolva többször 

egymás után veszít minőségi minden új formátumot generál. Minél 

alacsonyabb a kiválasztott bitsebesség, annál nagyobb a veszteség a 

minőség. Számos más kódok és formátumok - különösen formátumok, 

amelyek saját - már támogatott Audacity 1.3.6. a telepítés után az 

ffmpeg plug-inek (lásd Telepítés). 

Egynél több fájlba 

való importálás 
 Gyakran előfordul, hogy érdemes tárolni kész termelés különböző 

módokon - például mentés a számítógépen és égő rá egy audio CD-t. 

Talán, a CD-n, azt szeretnénk, különböző fejezeteket el kell különíteni 

egy sorozat szám. Vagy egy másik variáció: érdemes exportálni egy 

zenei album, vagy egy élő felvétel a több különálló MP3 fájlokat. Az 

ilyen műveletek a Fájl menü a funkció Export Multiple. 

Javasoljuk, hogy először egy címkét pályán szöveges markerek a 

távolságot foltok. Minden szöveg markerek tartalmaznia kell a nevét, a 

fejezet vagy zenei darab következik. Ezután, Export több, akkor létre 

az egyes fájlokat kezdve a helyeken a szöveg markerek, ha azt 

szeretnénk, a fájlok nevét és MP3 tagek származnak a szöveget 

markerek. Ez a funkció hasznos kezelésére hosszabb programok, 

amelyek strukturált tematikus blokkok és lehet bontani több fájlt. 

Több-csatornás audió   Audacity mentheti multi-track 

projektek többcsatornás hang, 

amely lehetővé teszi, hogy 

elérjék feltűnő hatást térhatású 

hangrendszerek, például amikor 

előállítására rádió játszik. 

Válassza a Szerkesztés> 

Beállítások> Import / 

Export, és válassza ki a 

párbeszédablak többcsatornás mix, továbbá meg kell 

választott formátum az export, amely támogatja a többcsatornás hangot 

(pl. WAV).  
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9. Gyors billentyűkombinációk 

 

A felsorolás  Több kulcs már hozzá a telepítés, lehetővé teszik a gyors munka. 

Ezeken, a további funkciók rendelhetők bármelyik gombot, vagy, ha 

szükséges, a meglévő feladatokat meg lehet változtatni. Javasoljuk, 

hogy vessen egy pillantást a Szerkesztés> Beállítások> 

Billentyűzet. 
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10. List of Keyboard shortcuts 

új Ctrl+N 

Megnyitni ... Ctrl+O 

közeli Ctrl+W 

Projekt mentése Ctrl+S 

ImportAudio Ctrl+Shift+I 

kijárat Ctrl+Q 

kibont Ctrl+Z 

helyrehoz Ctrl+Shift+Z 

vágott Ctrl+X 

Osztott Cut Ctrl+Alt+X 

Másolás Ctrl+C 

paszta Ctrl+V 

Beillesztése az új címke Ctrl+Alt+V 

állapot Ctrl+T 

töröl Ctrl+K 

Osztott törlése Ctrl+Alt+K 

Silence Hang Ctrl+L 

hasít Ctrl+I 

Osztott New Ctrl+Alt+I 

csatlakozik Ctrl+J 

Vegye le a Silence Ctrl+Alt+J 

másolat Ctrl+D 

vágott Alt+X 

Osztott Cut címkék Shift+Alt+X 

Copy címkék Shift+Alt+C 

Törlés címkék Alt+K 

Osztott törlése címkék Shift+Alt+K 

Silence Hang Alt+L 

Osztott címkék Alt+I 

Csatlakozzon címkék Alt+J 

szétválaszt címkék Shift+Alt+J 

Az összes kijelölése Ctrl+A 

Válassza a None Ctrl+Shift+A 

Állítsa be bal választás [ 

Set jobb választás ] 

Kövesse nyomon a Start Cursor Shift+J 

Kurzor To Track End Shift+K 
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Az összes kijelölése Tracks Ctrl+Shift+K 

SelSyncTracks Ctrl+Shift+Y 

Keresés Zero kereszteződések Z 

CursTrackStart J 

CursTrackEnd K 

Preferences ... Ctrl+P 

Nagyítás + 

Nagyítás Normál Ctrl+2 

Kicsinyítés - 

Fit in Window Ctrl+F 

elférjen Ctrl+Shift+F 

Nagyítás kiválasztása Ctrl+E 

Collapse All Tracks Ctrl+Shift+C 

Az összes kibontása Tracks Ctrl+Shift+X 

loop Play Shift+Space 

szünet P 

Ugrás elejére Home 

Ugrás a végére End 

rekord R 

Időzített felvétel ... Shift+T 

hozzáfűzése Record Shift+R 

Új hangformátum Ctrl+Shift+N 

Keverjük össze, és teszi az új pálya Ctrl+Shift+M 

Mute All Tracks Ctrl+U 

Mikrofon be All Tracks Ctrl+Shift+U 

Add Label At Selection Ctrl+B 

Add Label At lejátszási pozícióját Ctrl+M 

Ismételje Utolsó Effekt Ctrl+R 

ContrastAnalyser Ctrl+Shift+T 

Mozgás visszafelé eszköztárakat pálya Ctrl+Shift+F6 

Előrelépés az eszköztárakat pálya Ctrl+F6 

Selection Tool F1 

Boríték eszköz F2 

Döntetlen eszköz F3 

Nagyítás eszköz F4 

Time Shift eszköz F5 

Több eszköz F6 

Next eszköz D 

előző szerszám A 

Play / Stop Space 
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Play / Stop és Set Cursor Shift+A 

Lejátszás One Second 1 

Lejátszás kiválasztása B 

Lejátszás Cut Preview C 

Kiválasztása a Start Shift+Home 

Kiválasztása a végére Shift+End 

Rövid lejátszás közben bal keresik Left 

Rövid keresnek jobb lejátszás közben Right 

Hosszú keresik bal lejátszás közben Shift+Left 

Hosszú Keressétek lejátszás alatt Shift+Right 

Fókusz áthelyezése az előző felvételre Up 

Fókusz áthelyezése az előző, és válassza Shift+Up 

Fókusz áthelyezése a következő felvételre Down 

Fókusz áthelyezése gombra, és válassza Shift+Down 

Toggle Fókuszált pálya Return 

Toggle Fókuszált pálya NUMPAD_ENTER 

kurzor balra Left 

kurzor jobbra Right 

Kurzor Short Jump Bal , 

Kurzor Short ugrani . 

Kurzor Távolugrás Bal Shift+, 

Kurzor Távolugrás Right Shift+. 

Kiválasztás kiterjesztése Bal Shift+Left 

Kiválasztás kiterjesztése Right Shift+Right 

Selection szerződés Bal Ctrl+Shift+Right 

Selection szerződés Right Ctrl+Shift+Left 

Változás pan összpontosított pályán Shift+P 

Pan maradt fókuszált pályán Alt+Shift+Left 

Pan jobbra összpontosított pályán Alt+Shift+Right 

Változás nyereség összpontosított pályán Shift+G 

Növelje nyereség összpontosított pályán Alt+Shift+Up 

Csökkentse nyereség összpontosított pályán Alt+Shift+Down 

Nyissa meg a menüt az összpontosított pályán Shift+M 

Mikrofon ki / Mikrofon összpontosított track Shift+U 

Solo / Unsolo fókuszált track Shift+S 

Bezár összpontosított track Shift+C 

Teljes képernyő ki / be F11 

 


